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This quick start guide describes the parametrization of the servo drives 
Digitax M751 Base (Norgren Article Numbers QE/D0140400030 and 
QE/D02400105) for use with the servo motors supplied by Norgren.  
 
The Norgren standard parameter sets enable the user to quickly commission the servo drive and 
servo motor combinations supplied by Norgren. The standard parameter sets are available for 
download in the Technical Support section at www.norgren.com.  
 
The basic parameters enable the following functions: 
 
 Pairing of servo drive and motor 
 Setting of direction and speed of the rotation of the servo motor shaft using a potentiometer 

according to figure 4-30 “Default control terminal functions” in the “Installation and technical 
guide Digitax HD M75x Series” (digitally available at Nidec / Control Techniques at: 
https://acim.nidec.com/drives/control-techniques/products/servo-drives/digitax-hd/digitax-hd-
m751-base ) 

 The servo drive will then work in “Rotational velocity control” mode 
 The velocity control gain factors can be optimized regarding the inertia of the load if necessary 
 To avoid unintended damage to the actuators during commissioning the standard parameter 

sets limit the maximum torque of the motors to 15 % of the rated torque. Depending on external 
loads or the direction of the desired movement, this limit may be too low for commissioning. 
Necessary actions to increase the motor torque are also described in this guide. 

 The quick start guide includes three possible routes for parametrization of the drive: 
 Setting the parameters using a computer and the Ethernet/IP-option module 

o Setting up a new project 
o Connection via Ethernet/IP 
o Transfer of the parameter set using Ethernet/IP 

 Setting the parameters using a computer and the USB/EIA485 converter module 
o Setting up a new project 
o Connection using the USB/EIA485 converter module 
o Transfer of the parameter set using the USB/EIA485 converter module 

 Setting the parameters using a bootable SD card 
o Setting up a new project 
o Setting up a bootable SD card 
o Transfer of the parameter set from the SD card to the drive 

 
For parametrization the “Connect Drive Commissioning Software” is necessary. It can be 
downloaded free of charge under the following link after registration: 
 
https://acim.nidec.com/drives/control-techniques/products/servo-drives/digitax-hd/digitax-hd-m751-
base 
 
The guide for setting the parameters via Ethernet/IP can also be followed when using Ethernet 
based bus protocols like ProfiNet or EtherCAT. In this case the drive must be assigned an IP 
address manually before connecting it to the computer: The assignment must be executed using 
the bus master. Please consult the documentation of the respective bus systems for further 
information.  
 
  

http://www.norgren.com/
https://acim.nidec.com/drives/control-techniques/products/servo-drives/digitax-hd/digitax-hd-m751-base
https://acim.nidec.com/drives/control-techniques/products/servo-drives/digitax-hd/digitax-hd-m751-base
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To include the actuators in an independently controlled PLC system, additional files like EDS- or 
GSDML-files may be mandatory (depending on the bus system used). These are also available for 
download at https://acim.nidec.com/de-de/drives/control-techniques/products/servo-drives/unidrive-
m700-servo#. 
 
The files available for the Unidrive M drive series are also suitable for the Digitax HD series 
supplied by Norgren.  
 
When an independently controlled PLC system is used, the use of the PLC Controlled Motion 
Wizard within Connect Drive Commissioning Software is not advisable as the wizard overwrites 
parameters previously uploaded. For further guidance regarding positioning and speed control of 
the motors, please refer to chapters 4-6 of the PLC Controlled Motion guides offered by Nidec / 
Control Techniques. 
  

https://acim.nidec.com/de-de/drives/control-techniques/products/servo-drives/unidrive-m700-servo
https://acim.nidec.com/de-de/drives/control-techniques/products/servo-drives/unidrive-m700-servo
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Mechanical Installation 
 
Execute the mechanical installation of the actuator according to the Installation and Maintenance 
Sheet of actuator series E/809000, E/148000 or E/149000, respectively. These are issued with the 
actuator. They can also be downloaded in the Technical Support section at www.norgren.com. 

For the mechanical installation of the servo drives and cables please consult the “Installation and 
Technical Guide Digitax HD M75x Series”.  

 

Selection and download of the Norgren standard parameter 
sets 
 
The Norgren standard parameter sets can be found online in the Technical Support section at 
www.norgren.com. 

To select the suitable parameter set use the model number of your motor. This can be found on 
the type label (Figure 1, example 055UDB305BAEGA) 

 

Figure 1: Type label servo motor 

For motors with Multiturn feedback there are two different cable configurations available. These are 
preconfigured for different revisions of the EnDat protocol. The use of both cable configurations is 
possible through adapted parameters. Figure 2 shows how to differentiate between both cable 
configurations. The SC EnDat 2.1 cable is equipped with a straight D-Sub-Plug with a separate 
ground line whereas the EnDat 2.2 cable features an angled plug. 

http://www.norgren.com/
http://www.norgren.com/
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Figure 2: Differentiation between possible Multiturn feedback cable configurations 

Choose the parameter file according to the type number of your motor and the cable configuration 
used. Whether a motor with or without holding brake is used makes no difference for selecting the 
parameter file, see Table 1. 

Table 1: Selection of the correct parameter file 

Motor part 
number Norgren 

Motor part number 
Nidec 

(Given on the type 
label) 

Parameter file name 

QE/M05530/EA/09 055UDB300BAARA* 055UDB30_BAARA-QE_M05530_EA-09_Resolver 

QE/M05530/EB/09 055UDB300BAEMA* 055UDB30_BAEGA-QE_M05530_EB_09_MultiTurn_SC-EnDat2_1 
or 

055UDB30_BAEGA-QE_M05530_EB_09_MultiTurn_EnDat2_2 

QE/M05530/EM/09 0055UDB305BAARA* 055UDB30_BAARA-QE_M05530_EA-09_Resolver 

QE/M05530/EN/09 055UDB305BAEMA* 055UDB30_BAEGA-QE_M05530_EB_09_MultiTurn_SC-EnDat2_1 
or 

055UDB30_BAEGA-QE_M05530_EB_09_MultiTurn_EnDat2_2 

QE/M06730/JA/14 067UDB300BAARA* 067UDB30_BAARA-QE_M06730_JA_14_Resolver 

QE/M06730/JB/14 067UDB300BAEMA* 067UDB30_BAEGA-QE_M06730_JB_14_Multiturn_SC-EnDat2_1 
or 

067UDB30_BAEGA-QE_M06730_JB_14_Multiturn_EnDat2_2 

QE/M06730/JM/14 067UDB306BAARA* 067UDB30_BAARA-QE_M06730_JA_14_Resolver 

QE/M06730/JN/14 067UDB306BAEMA* 067UDB30_BAEGA-QE_M06730_JB_14_Multiturn_SC-EnDat2_1 
or 

067UDB30_BAEGA-QE_M06730_JB_14_Multiturn_EnDat2_2 

QE/M06730/NA/14 067UDC300BAARA* 067UDC30_BAARA-QE_M06730_NA_14_Resolver 

QE/M06730/NB/14 067UDC300BAEMA* 067UDC30_BAEGA-QE_M06730_NB_14_Multiturn_SC-EnDat2_1 
or 
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067UDC30_BAEGA-QE_M06730_NB_14_Multiturn_EnDat2_2 

QE/M06730/NM/14 067UDC306BAARA* 067UDC30_BAARA-QE_M06730_NA_14_Resolver 

QE/M06730/NN/14 067UDC306BAEMA* 067UDC30_BAEGA-QE_M06730_NB_14_Multiturn_SC-EnDat2_1 
or 

067UDC30_BAEGA-QE_M06730_NB_14_Multiturn_EnDat2_2 

QE/M08930/RA/19 089UDC300BAAEA* 089UDC30_BAAEA-QE_M08930_RA_19_Resolver 

QE/M08930/RB/19 089UDC300BAECA* 089UDC30_BAECA-QE_M08930_RB_19_MultiTurn_SC-EnDat2_1 
or 

089UDC30_BAECA-QE_M08930_RB_19_MultiTurn_EnDat2_2 

QE/M08930/RM/19 089UDC306BAAEA* 089UDC30_BAAEA-QE_M08930_RA_19_Resolver 

QE/M08930/RN/19 089UDC306BAECA* 089UDC30_BAECA-QE_M08930_RB_19_MultiTurn_SC-EnDat2_1 
or 

089UDC30_BAECA-QE_M08930_RB_19_MultiTurn_EnDat2_2 

QE/M11530/WA/24 115UDC300BAAEA* 115UDC30_BAAEA-QE_M11530_WA_24_Resolver 

QE/M11530/WB/24 115UDC300BAECA* 115UDC30_BAECA-QE_M11530_WB_24_MultiTurn_SC-EnDat2_1 
or 

115UDC30_BAECA-QE_M11530_WB_24_MultiTurn_EnDat2_2 

QE/M11530/WM/24 115UDC306BAAEA* 115UDC30_BAAEA-QE_M11530_WA_24_Resolver 

QE/M11530/WN/24 115UDC306BAECA* 115UDC30_BAECA-QE_M11530_WB_24_MultiTurn_SC-EnDat2_1 
or 

115UDC30_BAECA-QE_M11530_WB_24_MultiTurn_EnDat2_2 
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Setting up a new project 
 
Open “Connect Drive Commissioning Software”. The start screen is opened. Create a new project.  

 

Figure 3: Connect Drive Commissioning Software start screen 

Choose a name and directory.  

 

Figure 4: Setting up a new project 

An empty window opens. The name of the project is shown in the top (here: “Test_Project_IMI”). 

 



 
 
 

 9 

Servo Drives Digitax M751 

 

M-P76372 / Rev. 3 

Establish Connection via Ethernet/IP 
 
The following chapters describe setting the parameters of the servo drive using the Ethernet/IP 
option module. It can be purchased under the type number QE/B179000/EN.  

The same steps can be followed when using Ethernet based bus protocols like ProfiNet or 
EtherCAT. In this case, the drive must be assigned an IP-address using an external bus master 
prior to connecting it to the computer. For further advice please consult the documentation of the 
bus systems. 

To connect the drive to the computer click “Add drive” and choose “Search for new drives”. Now 
the local network is searched for connected servo drives.  

 

Figure 5: Search local network for drives 

All servo drives found in the search are shown. Every drive is assigned an IP address and its type 
is detected. In this example, one drive is connected to the network, only, see. Figure 6. 
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Figure 6: Adding the drives connected to the network 

Select the drive that shall be connected to the project by setting the mark and confirm by clicking 
“OK”. The drive is now added to the project and shown in the project tree on the left hand side. 
Now the dashboard of one of the drives is shown in the center window, see Figure 7. 

 

Figure 7: Project dashboard 
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Transfer of the parameter set via Ethernet/IP 
 
To load a parameter set onto the drive, click the “Online” button on the dashboard as shown in 
Figure 8. 

 

Figure 8: Create "online"-connection to the drive 

The selected drive as well as the respective dashboard are now high-lighted in green, see Figure 
9. 

 

Figure 9: Create "online"-connection to the drive (2) 
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Select the drive and click “Properties” in the “View” tab. The “Drive properties” window is opened. 
You can compare the serial number of the drive with the connected drive, here. The serial number 
can be found on the type labels on top and on the side of the drive.  

 

Figure 10: Drive properties and identification of the connected drive 

To download the Norgren standard parameter sets to the drive select “download to drive” in the 
project dashboard, see Figure 11. 

 

Figure 11: Download to the drive 

A window opens. Navigate to the directory containing the Norgren standard parameter sets and 
select the appropriate parameter file. Confirm with “Open”, see Figure 12. 
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Figure 12: Opening a parameter file 

 

If more than one option module is installed to the drive, a warning appears. This can be closed.  

 

Figure 13: Warning for multiple option modules 

To save the parameter set, select “Save parameters to drive” on the “Start” tab. 
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Figure 14: Save parameters to drive 

Now the setting of the parameters is complete. Repeat the steps shown in this guide for all other 
drives in use. 

If necessary, it is also possible to rename the drives. To do so, right-click the servo drive in the 
project tree. Then click “Rename” or use the “Device properties” window already open to edit the 
device name. In this example, the name “Drive 2.2 A” is used. This step must be executed after 
loading the standard parameters to the drive. Otherwise, the newly edited name will be overwritten 
by the standard.  

 

Figure 15: Renaming the drive 
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Establish Connection via the USB/EIA485 Converter Cable 
 
The following chapters describe setting the parameters of the drive using the USB/EIA485 
converter cable. It can be purchased under the type number QE/A4500/0096. 

The USB/EIA485 converter cable enables the user to establish a connection between any USB 
port of the computer in use and one of the EIA485 ports of the drive. Both EIA485 ports can be 
used. 

To establish a connection to the drive, click “Add drive” and select “Search for new drive”. 

 

Figure 16: Search local network for new devices 
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To search for devices that are connected using the converter cable, click the “Settings” button in 
the opened search window, see Figure 17. 

 

Figure 17: Adding drives using the serial port 

Check the box “Search RTU (serial)” in the RTU window, see Figure 18. 

 

Figure 18: Searching the serial connection 
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Any found drives will now be listed in the search window. Every drive is assigned an IP address 
and its type is detected, see Figure 19. 

 

Figure 19: Adding drives using the serial connection 

Select the drive by ticking the box and confirm with “OK”. The selected drives will now be added to 
the project. They are now visible in the project tree. The center window now shows the project 
dashboard for one of the drives, see Figure 20 

 

Figure 20: Project dashboard 
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Transfer of the parameter set using the USB/EIA485 converter cable 
 
To transfer the parameter sets onto the drives using the USB/EIA485 converter cable, the same 
steps as described for the Ethernet/IP connection must be followed. Analogue to the setup using 
an Ethernet/IP connection, properties of the drive can be read and edited.  

To load a parameter set onto the drive, click the “Online” button on the dashboard as shown in 
Figure 21. 

 

Figure 21: Online connection to the drive 

The selected drive and its dashboard are now high-lighted in green, see Figure 22. 

 

Figure 22: Online connection to the drive (2) 
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Select the drive and click “Properties” in the “View” tab. The “Drive properties” window is opened. 
You can compare the serial number of the drive with the connected drive, here. The serial number 
can be found on the type labels on top and on the side of the drive.  

 

Figure 23: Device properties and identification of the servo drive 

To download the Norgren standard parameter sets to the drive select “download file to drive” in the 
project dashboard, see Figure 24. 

 

Figure 24: Download to the device 
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A window opens. Navigate to the directory containing the Norgren standard parameter sets and 
select the appropriate parameter file. Confirm with “Open”, see Figure 25. 

 

Figure 25: Opening a parameter file 

If more than one option module is installed to the drive, a warning appears. This can be closed.  

 

Figure 26: Warning for multiple option modules 
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To save the parameter set, select “Save parameters to drive” on the “Home” tab. 

 

Figure 27: Save parameters to device 

Now the setting of the parameters is complete. Repeat the steps shown in this guide for all other 
drives in use. 

If necessary, it is also possible to rename the drives. To do so, right-click the servo drive in the 
project tree. Then click “Rename” or use the “Device properties” window already open to edit the 
device name. In this example, the name “Drive 2.2 A” is used. This step must be executed after 
loading the standard parameter set to the drive. Otherwise, the newly edited name will be 
overwritten by the standard.  

 

Figure 28: Renaming the drive  
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Setting up a bootable SD-card 
 
The following chapters describe setting the parameters of the drives using a bootable SD card. 
After parametrization the SD card may be removed from the drives. Therefore, setting up a single 
bootable SD card is beneficial if multiple identical combinations of servo drive and servo motor are 
used.  

Open the “SD card manager” under “Tools & Wizards” in the “Home” tab.  

 

Figure 29: Opening the SD card manager 

Now select the „Prepare“ button.  
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Figure 30: Preparation of the SD card 

Select the “From a parameter file” option under “Which parameters?”. Select “Bootable parameter 
file” as “Filetype for SD card”. By clicking the “…” button the selection window for the parameter 
files is opened.  

 

Figure 31: Setting up a bootable SD card 

Select the parameter file appropriate to the motor and feedback cable revision as described before. 
Confirm by clicking “Open”.  

 

Figure 32: Selection of a parameter set 

Now, the set-up of the bootable SD card is complete, and the SD card can be removed securely 
from the SD card slot of the computer.   
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Transfer of the parameters from the SD card to the drive 
 
To transfer the parameter set from the SD card to the drive, the card is inserted to the SD card slot 
on the front of the drives. Now, a brief manual interruption of the 24 V DC connection to the drive is 
necessary. The drive now reboots and loads the parameters from the SD card to its internal 
memory. 

A blinking status LED on the front of the drive indicates that a reset is necessary. To reset the 
drive, briefly press the reset button. Constant illumination of the LED indicates successful loading 
of the parameter set. Now the drive is ready for use. The SD card can now be removed from the 
slot. 

Maximum motor torque 
 
Parameters 4.005 to 4.007 define the motor torque limits. To avoid unintended damage to the 
actuators during commissioning, the Norgren standard parameter sets limit of the maximum motor 
torque to 15 % of the rated torque of the motor. The values of the parameters 4.005 to 4.007 can 
be increased after commissioning. A maximum value of 300 % of the rated torque is possible. For 
acceleration and deceleration differing values can be put into parameters 4.005 and 4.006. 
Alternatively, parameter 4.007 offers a symmetric value for both. If differing values are selected, 
the smaller value is used.  
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Use of Macro Files during Commissioning 
Depending on the desired functionality of the Norgren ELION actuator and the configuration of 
peripheral systems to the drive several parameters need to be set in addition to the standard 
parameter sets. To simplify this procedure, a range of Macro Files is available. These can be 
added to the configuration in Connect Software. The following abstracts show how to load the 
Macros into connect and how to download the settings to the drive. Following this, the Macro Files 
provided by Norgren are listed and commented on in more detail. 

To include the macro files into the current project, right click on “Macro Files” in the “Project” 
Window in Connect: 

 

Figure 33: Add macro files to the project 
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Now copy all desired macro files from the selected folder into the project: 

 

Figure 34: Select Macro Files 

The selected macro files are now shown in the macro file folder in the Project window in Connect. 

 

Figure 35: Selected Macro Files in Connect 
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Now, the parameter changes defined by each macro file can be executed by downloading the 
selected file to the drive (see Figure 36). To do so, the drive must not be enabled, i.e. at least one 
of the STO input signals (parameters #08.009 and #08.040) must be low. 

 

Figure 36: Download Macro to the Drive 

Afterwards, all parameter changes should be saved in the drive to transfer them to the non-volatile 
memory of the drive: 

 

Figure 37: Save parameter changes 
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Selection of Macro Files 
Table 2 gives a short description for the Macro Files available for the drive range offered by 
Norgren. To simplify the selection of the necessary Macro Files for the application, please refer to 
the guidance given in the MacroSelection sheet available for download from the Norgren website 
(www.norgren.com). Figure 38 gives an overview where the different terminals mentioned in Table 
2 can be found.  

Table 2: List of Macro Files 

Macro File Description 

MA751-01_HoldingBrakeActuation - Enables the use of the holding brake if necessary  
- Delay times are set according to the mechanical behaviour of the 

holding brake 

MA751-02_AMC_enable - Enables the use of the Advanced Motion Controller  
- Simplifies settings for positioning, speed ramps, referencing the actuator 

etc. 

MA751-03_1_HomingMechanicalEndStop - Enables the use of a mechanical end stop of the actuator connected to 
the motor for homing  

- Speed of the actuator during the homing sequence is limited to 10 rpm  
- Torque thresholds for hard stop detection are set 

MA751-03_2_HomingPositionSwitches - Enables the use of a limit switch for the referencing procedure 
- Speed of the actuator during the homing sequence is limited to 10 rpm. 

MA751-04_1_ 
HomingTerminalControlUsing 
HardwareLimitSwitchesConfig 

- Requires an SI-IO option module mounted in Slot 2 of the drive 
- Sets the “Run Forward” parameter to Digital Input 4 of the drive 
- Limit switches are enabled and connected to DI 2 and 3 of the SI-IO 

module 
- Parameters #06.035 and #06.036 (limit switches) are connected through 

to the homing function 

MA751-04_2_ 
HomingBusControlWith 
HardwareLimitSwitchesConfig 

- Does not require SI-IO option module 
- Requires Bus option module (e.g. ProfiNet or EtherCAT) 
- Digital Input 4 and 5 are set to the positive and negative limit switch, 

respectively 
- Homing limits are set to the limit switches 

MA751-04_3_ 
HomingTerminalControlWithout 
HardwareLimitSwitchesConfig 

- Run Forward is set to Digital Input 4  
- Other input terminals are not used 

MA751-05_1_HomingMechanical 
EndStopPositiveLimit 

- Homing mode is set to positive limit (with respect to motor rotation): 
- Motor end stop for E/809***/***/N**/**** and E/148***/B**/***/**** 
- Far end stop for E/809***/***/D**/****, E/149*** and E/148***/A**/***/**** 

MA751-05_2_HomingMechanical 
EndStopNegativeLimit 

- Homing mode is set to negative limit (with respect to motor rotation) 
- Far end stop for E/809***/***/N**/**** and E/148***/B**/***/**** 
- Motor end stop for E/809***/***/D**/****, E/149*** and 

E/148***/A**/***/**** 

MA751-06_1_BrakingResistor_50W - Sets the parameters to include the 50 W braking resistor (Norgren part 
number QE/A9500/1049) 

MA751-06_2_BrakingResistor_100W - Sets the parameters to include the 100 W braking resistor (Norgren part 
number QE/A1220/2801) 

MA751-07_1_HardwareLimitSwitches_NO 
_BusControl 

- DI 4 and 5 of the drive or DI 2 and 3 of the SI-IO module are used for the 
limit switch signals 

- Sets digital input signals for the limit switches to use Normally Open limit 
switches 

MA751-07_2_HardwareLimitSwitches_NC 
_BusControl 

- For use with field bus systems, only 
- DI 4 and 5 of the drive or DI 2 and 3 of the SI-IO module (if mounted to 

slot 2 of the drive) are used for the limit switch signals 
- Sets digital input signals for the limit switches to use Normally Closed 

limit switches 

MA751-07_3_HardwareLimitSwitches_NC 
_TerminalControl 

- For use with terminal control 
- DI 4 of the drive is used for the Run Forward signal 
- DI 2 and 3 of the SI-IO module (mounted in slot 2 of the drive) are used 

for limit switch signals 

MA751-08_1_ 
FeedbackCable_EnDat_2_2RevOrResolver 

- Resets the feedback system for the use of an EnDat 2.2 Cable revision 
(Multiturn) or a Resolver feedback system (See Figure 2) 

http://www.norgren.com/technical-support/
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MA751-08_2_ 
FeedbackCable_EnDat_2_1Rev_ 
MotorSize55-67 

- Sets the feedback system for the use of an SC EnDat 2.1 Cable revision 
(see Figure 2) in combination with motor sizes 055 and 067 (Norgren 
motor type numbers QE/M05530/EB/09, QE/M05530/EN/09, 
QE/M06730/JB/14, QE/M06730/JN/14, QE/M06730/NB/14, and 
QE/M06730/NN/14 

 

 

Figure 38: Digital Inputs of the Drive and SI-IO Option Module 

 

  

SI-IO Terminal: 

SI-IO T3: DI-3 SI-IO T2: DI-2 

Drive IO Terminal: 

Drive T13: DI-3 

Drive T11: DI 4 

Slot 2: 

SI-IO 

Slot 1: freely 

configurable 
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Positioning and speed control  
The servo motors and drives supplied by Norgren offer a comprehensive positioning and speed 
control capability. Rotational movement of the motor shaft is calculated in User Units that are 
proportional to the linear distance travelled by the actuator piston rod or carriage, respectively. To 
simplify the conversion calculations, a Positioning Calculation tool is also part of the download 
package. The tool offers a conversion between the parameters given in Table 3 depending on the 
actuator size and configuration. 

Table 3: Conversion Table 

Parameter Conversion 

Stroke (distance travelled) mm → UU 

Velocity mm

s
 →

UU

ms
 

Acceleration / Deceleration mm

𝑠2
→

UU

ms2
 

 


